Setup of Eclipse with new Jakarta EE support on latest
Tomcat: and creation of Dynamic Web Project
w/Servlet

ITEM 1= Transitioning from Java EE to opensource Jakarta EE

READ TH |S- https://blogs.oracle.com/javamagazine/transition-from-java-ee-to-jakarta-ee

The API JAR files had their Maven group ID changed
from javax.* to jakarta. *,

ITEM 2= Install of Eclipse and setup project with A Jakarta
Tomcat Container (for run time)based “Dynamic Web Project
Project in Eclipse

1

Install Eclipse IDE for Enterprise Java Developers (make sure you get the Enterprise Java Developer
version).

>go to eclipse.org and find the LATEST version.

Example at time of creation of the document it was
https://www.eclipse.org/downloads/packages/release/2020-12/r/eclipse-ide-enterprise-java-

developers

ITEM 3= Create Dynamic Web Project with A Jakarta Tomcat
Container (for run time)

NOTE: first time it will prompt you to install Tomcat if you do not have it installed

1) File ->New Project-> Dynamic Web


https://blogs.oracle.com/javamagazine/transition-from-java-ee-to-jakarta-ee
https://www.eclipse.org/downloads/packages/release/2020-12/r/eclipse-ide-enterprise-java-developers
https://www.eclipse.org/downloads/packages/release/2020-12/r/eclipse-ide-enterprise-java-developers

2) Specify name and select New Runtime (only need to do this first time)

Lets use a version of Apache Tomcat (a simple servlet container) and then you will need to
either find the local location or do a download and install
E'% Dynamic Web Project O X -
Dynamic Web Project

7

)
Create a standalone Java-based Web Application or add it to a new or existing Enterprise Application.

Project name: | MyDynamicWebProject ‘

Project location

Use default location
C\Users\lynne\eclipse-workspace\MyDynamicWebProject Browse...

Target runtime

<None> New Runtime...

Dynamic web module version
40

E MNew Server Rufitime Hhvironment O

Configuration Tomcat Serwv [g
Default Configuration Specify the installatid¢/directory

The default configuration provides a good starting point. Additional facets can later be|
functionality to the project.

Name,
EAR membership {Gpache Tomcat vioo D) |
[ Add project to an EAR TW

EAR

‘ Browse...
Working sets

apache-tomcat- 192 | Download and Install... r
[[] Add project to working sets JRE: ]

Workbench default JRE ™ Installed JREs...

@ < Back Next > Finish

@ < Back Next > Finish Cancel

Here | specified my C: drive for location to install



E New Server Runtime Environment

Tomcat Server

Specify the installation directory

Name:

| Apache Tomcat v10.0

Tomcat installation directory:

| C./apache-tomcat-10.0.2

‘ Browse...

apache-tomcat-10.0.2 | Download and Install...

JRE:
Workbench default JRE ™ Installed JREs...
® < Back Next > Finish Cancel

| will then get back the first frame

E New Dynamic Web Project

Dynamic Web Project

O X

s

@
Create a standalone Java-based Web Application or add it to a new or existing Enterprise Application.

Project name: | MyDynamicWebProject

Project location
Use default location

Location: | C\Users\lynne\eclipse-workspace\MyDynamicWebProject

Target runtime

Apache Tomcat v10.0

Dynamic web module version

4.0

Configuration

Default Configuration for Apache Tomcat v10.0

Browse...

~ || New Runtime...

~ Modify...

A good starting point for working with Apache Tomcat v10.0 runtime. Additional facets can later be installed

to add new functionality to the project.

EAR membership
Add project to an EAR

EAR project name: | MyDynamicWebProjectEAR

Working sets
[] Add project to working sets

Working sets:

MNew Project...

~ Select...

@ < Back




-: Creation of Dynamic Web Application with _

(uses modern Annotations) in Eclipse with Tomcat

1) File ->New-> Dynamic Web Project
specify the name and do not select web.xml

[ﬂ New Dynamic Web Project

O X
Dynamic Web Project

")
Create a standalone Java-based Web Application or add it to a new or existing Enterprise Application.

Project name: | MyTestDynamicWebProj: ectNOWebXMIJ |

Project location
Use default location

C:\Users\lynne\eclipse-workspace\MyTestDynamicWebProjectNOWebXML Browse...

Target runtime

Apache Tomcat v10.0 ~ || New Runtime.

Dynamic web module version
40

Configuration

Default Configuration for Apache Tomcat v10.0 ~ Modify...

A good starting point for working with Apache Tomeat v10.0 runtime. Additional facets can |ater be installed
to add new functionality to the project.

EAR membership
Add project to an EAR

EAR

New Project...
Working sets
[J Add project to working sets New.
Select.

@ <Back Next > Cancel

8 New Dynamic Web Project

[m]
Web Module

X

Contextroot: | MyTestDynamicWebProjectNOWebXML |

Content directory: | sre/main/webapp ‘

[ Generate webxml deployment descriptor don't select this and will
use more modern Java EE
standard of annotations
over web.xmi
specifications

®@ < Back Next > Cancel

Resulting structure...notice there is no Servlet, no JSP or HTML but, just an
empty project structure waiting for YOU to add those things



~ & MyTestDynamicWebProjectNOWebXML
22 JAX-WS Web Services
=\ JRE System Library [JavaSE-15]
2 src/main/java
=\ Apache Tomcat v10.0 [Apache Tomcat v10.0]
s Deployment Descriptor: MyTestDynamicWebProjectNOWebXl
= build
v [= src
~ [ main
= java
v = webapp
~ = META-INF
= MANIFEST.MF
~ [= WEB-INF
& lib

2) Add a servlet (right click on src/main/java or on project and new -> other-
>servlet ....or similar). Fill out the form with package name, servlet name
and URL mapping(s) you wish.

18] Create Servlet | X
Create Servlet G ;_;;)
Specify class file destination.

Project: MyTestDynamicWebProjectNOWebXML e

Source folder: | /MyTestDynamicWebProjectNOWebXML/src/main/java | Browse...
Java package: | | Browse...

Class name: | MyServIe‘d |

Superclass: | Jjavax.servlethttp.HttpServiet | Browse...

[Juse an existing Servlet class or JSP

| MyServiet | Browse...

@ < Back Next = Cancel




&

Create Servlet G __-}‘i\

Enter servlet deployment descriptor specific information.

Name: | MyServlet |

Description: | |

Initialization parameters:

Name & URL Mappings X Add..
Pattern: | ,"Iynne| Edit...
Remove
URL mappings:
/MyServiet Add...
Edit...
Remove
[ Asynchronous Support
@' < Back Mext = Cancel

3) NOW YOU need to make sure you are using jakarat packages and not javax
(so I manually change this in the servlet code). ---I am not sure why it
defaults to the javax (older Java EE) rather than the newer jarkata EE
package or how to fix this.

B “MYSEVIET java s

- import java.io.IOException; Tomcat uses jakarta and nto javax

import javax.servlet.ServletException; for the last ** versions of Tomcat
import jakar“ta.ser‘vle‘t.Ser‘vle‘tExcep‘ticD

import javax.servlet.annotation.WebServlet; ?

import jakarta.servlet.annotation.WebServlet$

import javax.servlet._http.HttpServlet; SO YOU MUST repface the imports

import jakarta.servlet.http.HttpServlet; with the equivalent in the jakarta package

@10 import javax.servlet.http.HttpServletRequest;
11 import jakar“ta.s.er‘\.l'le‘t.h‘t‘tp.H‘t‘tpSer‘\.l'le‘tReques.‘t:;I

@12 import javax.servlet._ http.HttpServletResponse;
12 import jakarta.servlet.http.HttpServletResponse; -/-

=]
(=R RN Bl e IRV, B R W N I )

* Servlet implementation class MyServlet

*/

...... here is the result of my doing this. Notice the web annotation @WebServlet
and here | specified 2 URL mappings that will work

import java.io.IOException;

import jakarta.servlet.*;

import jakarta.servlet.annotation.*;
import jakarta.servlet.http.*;




/*

import
import
import
import
import

/**

javax.
javax.
javax.
javax.
javax.

servlet
servlet
servlet
servlet
servlet

.ServletException;
.annotation.WebServlet;
.http.HttpServlet;
.http.HttpServletRequest;
.http.HttpServletResponse;*/

* Servlet implementation class MyServlet

*/

@WebServlet({ "/MyServlet", "/lynne" })
public class MyServlet extends HttpServlet {

4) Run by right clicking on project and say run as. However, typically you will
add index.html or jsp pages and those will be run instead of directly as
server. to your dynamic web applications...but, that is another discussion.

:ctNOWebXML/ - Eclipse IDE

dow Help
AT AT G rE YIS A YRR OOy D v |2

|X] web.xml

[7] Servlet2 java

[ MyServletjava @ httpy//local... [ MyServietjava @ HTTP Status.. 2 ™

SV ST |http://locaIhost:SDSD/MyTestDynamicWebProjectNOWebXML/ N

MH1 TP Status 404 — Not Found

m Status Report
[[EFEENTE The requested resource [/MyTestDynamicWebProjectNOWebXML/] is not available

The origin server did not find a current representation for the target resource or is not willing to disclose that one exists.

[Apache Tomcat/10.0.2

NOTE as there is no index.* file and hence we get a 404...change the url you
see here and append to it the web annotation endpoint. For example, |



will add /lynne to the end of the url and now it will invoke my servlet

IUVWEDANILS - CLIPSE ILE

w~ Help

rAY BTSRRI YR OOy v

£ webxml [7] Serviet2 java [71 MyServiet java @ http://local... [ MySenvletjava @ htip://local.. n

= Sl d |http://locaIh0st:BDBDIMyTestDynamicWebProjectNOWeb)( fL/lynne v

Served at: /MyTestDynamicWebProjectNOWebXML

Because | have TWO url mappings specified in the annotation @WebServlet
in my Servlet java code, | can use either of them to invoke the servlet. Here

you can see the send running

1% web.xml [1] Servlet2 java [J] MyServletjava @ http://local... @ MyServiet.java @ httpe//local...

o & = | httpy//localhost:8080/MyTestDynamic\WebProjectNOWbXML/MyServiet I
1 ]

¢ Served at: /MyTestDynamicWebProj ectNOWebMV



-: Creation of Dynamic Web Application with - in

Eclipse with Tomcat

1) Step 1-3 are the same except you select the web.xml creation box.

2) Edit the web.xml file so that the Desired URL mappings for your new
servlet are setup.
...here is an example for a servlet | created called LynneServlet that is
mapped to /lynne and then you can see me running it and the
corresponding url

“lipse-workspace - MyTomcatDynamicWebProject/src/main/webapp/WEB-INF/web.xml - Eclipse IDE
Edit Source Mavigate Search Project Run Sapphire Samples Window Help

EQiIDiw|m BN SR -0 R ALy B Y®@E IR RSO -
oject Explorer &2 BES Yo § =0 [X] webxml % webxml & [I] LynneServle.. @ HTTP Status... @ http://local... E
1 <?xml version="1.8" encoding="UTF-8"?>
et 2= <web-app xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance” xmli

3 <display-name>MyTomcatDynamicWebProject</display-name>
42 <welcome-file-list>

5 <welcome-file>index. html</welcome-file>

6 <welcome-file>index.htm</welcome-file>

7 <welcome-file>index. jsp</welcome-file>

8 <welcome-file>default _html</welcome-file>
<welcome-file>default. htm</welcome-file>
<we1come—file>defaultLjsp</we1come—¥ile>

11 </welcome-file-1ist>

12
132 <servlet>
14 <servlet-name>LynneServlet</servlet-name>
15 <servlet-class>LynneServlet</servlet-class>
16 </servlet>
17
8=  <servlet-mapping>
9 <servlet-name>LynneServlet</servlet-namg
» MyTomcatDynamicWebProject ? fig:\l]Eifiig::ﬁ nnequrl-pattern>

‘s Deployment Descriptor: MyTomcatDynamicWebProject
2 JAX-WS Web Services

=\ JRE System Library [JavaSE-15]

# src/main/java

=, Apache Tomcat v10.0 [Apache Tomcat v10.0]
= build
= src

~ = main

22 </web-app> \

b G Gre - @)Nv @R YPF vy
X web.xml 1 web.xml LynneServle... @ HTTP Status... @

= - |http://localhDst:BDBD/MyTDmcatDynamicWebProjer:t/Iynne

<

- & java i Design Efso  Served at: /MyTomcatDynamicWebProject

LynneServletjava
v (= webapp
+ [= META-INF
| MANIFEST.MF
v (= WEB-INF
sl
I 14 web.xml I
[zl LynnelSP,jsp

[ Markers [l P

B Tomcatrﬂ

+ Servers

o Trmamnat A AN Canrne nt bamalhmet moanfis



ITEM 4= Adding html and jsp pages to your project
Create an html page to call the servlet class on a webpage

We are creating an html file that would call the servlet once we click on the link
on web page. Create this file in WebContent folder. The path of the file should
look like this: WebContent/index.html

index.html

NOW lets create our index.html page that will invoke our sevlet. Right click on web folder and
create NEW html file

<!DOCTYPE html>

<html>

<head>

<meta charset="UTF-8">
<title> Servlet Demo</title>

</head>

<body>

<a href="welcome">Click to call Servlet</a>

</body>

</html>
ivLEIJuLDJE&| | jﬁ#v@vﬁv%v.‘fﬁv@v@@.jv@;‘g_v - ¥
Project Explorer ES v e § - O MyServietjava @ HTTP Status 404 — Not Found |
2 MyDynamicWebProject 1 <!DOCTYPE html>

‘g Deployment Descriptor: MyDynamicWebProject 25 <html>

3= <head>
4 <meta charset="UTF-8">
5 <titlerk Servlet Demo</title>

A JAX-WS Web Services
=\ JRE System Library [JavaSE-15]

# src/main/java 6 </head>
=\ Apache Tomcat v10.0 [Apache Tomcat v10.0] 7¢ <body>
= build 8 <a href="welcome">Click to call Servlet:
v [ srC 9 </body>
v B main 18 </html>
v [= java
MyServietjava
~ [= webapp
= META-INF
(= WEB-INF
index.html
= Servers

= Tomcat v10.0 Server at localhost-confia

NOW click on Run on your tomcat server RIGHT click on index.html -> run on
server and select your tomcat server



@] Run On Server ] X

Run On Server Ig

Select which server to use

How do you want to select the server?
@ Choose an existing server
() Manually define a new server
Select the server that you want to use:
| type filter text

Server State
~ (= localhost
5 Tomcat v10.0 Server at localhost fia Stopped

Apache Tomcat v10.0 supports J2EE 1.2, 1.3, 1.4, and Java EE 5, 6, 7, 8 and Jakarta EE 9 Columns...
Web modules.

[] Always use this server when running this project

@ < Back Next > Cancel

Here is the result of running index.html

rct/index.ntmi - tclipse IDE

Window Help
TR AU BrEYIEB AR F eIy
8 [@ MyServietjava [2 index.html @ k Servlet Demo %) web.xml @ kServlet Demo

= &'« | http://localhost:8080/MyDynamicWebProject/index.html

Click to call Servlet

AND clicking on the link | will get my servlet

WebProject/index.html - Eclipse IDE
Samples Window Help
FrO*R-QA> PrE- @S I/ QIR rHHrOD OO
@ § = 3 [ Mmysenletjava indexhiml @ kServietDemo ¥ webxml @k Sel

(] & - |hrtp:."/IDEalhost:EOBDfMyDynamicWemeject/‘welcome

Served at: /MyDynamicWebProject



NOTE you can add JSP file in the same fashion. Both JSP and HTML files will put
under webapp directory and both can be directly run

ﬂ eclipse-workspace - http://localhost:8080/MyTomcatDynamicWebProject/Lynne)SPjsp - Eclipse IDE
File Edit Mavigate Search Project Run Sapphire Samples Window Help

g E®\|I- l:,;-:_=77777| _ﬁ?#vﬁv&v%vfﬁvﬁ?v@@gv@fﬁ77 ok o - '|E
o Project Explorer &2 == | & £ 7 8 [ webxml %] webxml [3] LynneServie... @ HTTP Status... @ http://local...
v & MyDynamicWebProject o @S ‘http:fflocalhost:BDBDJMyTOmcatDynamicWebProjchLynneJSP.jsp

‘g Deployment Descriptor; MyDynamicWebProject

A JAX-WS Web Services hi lynne this is static so far

=\ JRE System Library [JavaSE-15]
2 src/mainfjava
=i Apache Tomcat v10.0 [Apache Tomcat v10.0]
= build
A=
~ = main
v = java
MyServletjava
v (= webapp
= META-INF
~ [= WEB-INF
& lib
¥ web.xml
[l index.html
v & MyTomcatDynamicWebProject
'ia Deployment Descriptor: MyTomcatDynamicWebProjct
2 JAX-WS Web Services
= JRE System Library [JavaSE-15]
# src/main/java
=\ Apache Tomcat v10.0 [Apache Tomcat v10.0
= build
v [ src
v (= main
v (= java
LynneServietjava
+ [= webapp
~ [= META-INF
2 MANIFEST.MF
~ [= WEB-INF
Ll
%] webxml
[ LynnelSPjsp

[2 Markers [ Properties % Servers 2 % Data Source Explorer [ Snippets B Console
[ Tomcat v10.0 Server at localhost [Started, Synchronized]

v 1= Servel
= Tomcat v10.0 Server at localhost-config



ITEM 4: miscellaneous...tips, etc.

MAKE SURE your project has the Project Properties -> Java Build Bath- and it contains the Apache
Tomcat (hit apply and close)

{8 properties for MyTomcatDynamicWebProject O X
Java Build Path [ S g

Resource ~

Builders * Source = Projects =i Libraries “% Order and Export @ Module Dependencies

Coverage Build class path order and exported entries:

Deployment Asser (Exported entries are contributed to dependent projects)

Java Build Path [[] =4 JRE System Library [JavaSE-15] Up

Java Code Style [®] = MyTomcatDynamicWebProject/src/main/java Down

Java Compiler B\ Apache Tomcat v10.0 [Apache Tomcat v10.0]

Javadoc Location []= Web App Libraries Ton

Java Editor [ =\ EAR Libraries

JavaScript Bottom

JSP Fragment

Project Facets Select All

Project Natures

Project References DEEliEER Al

Run/Debug Settim

Server

Service Policies

Targeted Runtime:

Task Repository v

< > Apply

Apply and Close Cancel




